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Copyrights & Warranty 
© Copyright 2003 by Visonic Ltd., 24 Habarzel Street, Tel-Aviv 69710, ISRAEL. All 
Rights Reserved. 

No part of this publication may be reproduced or distributed in any form or by any means, 
electronic or mechanical, for any purpose, without the express written permission of 
Visonic Ltd. 

Microsoft is a registered trademark of Microsoft Corp. 
All other products or services referred to in this manual are the trademarks, service marks, or 
product names of their respective holders. 

DISCLAIMER: The information, products and specifications, configurations, and other 
technical information regarding the products contained in this manual are subject to change 
without notice. All the statements, technical information, and recommendations contained 
in this manual are believed to be accurate and reliable but are presented without warranty 
of any kind, and users must take full responsibility for the application of any products 
specified in this manual. 
IN NO EVENT SHALL VISONIC OR ITS SUPPLIERS BE LIABLE FOR ANY 
INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, 
INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE 
TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, 
EVEN IF VISONIC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. 

WARRANTY 
Visonic Ltd. and/or its subsidiaries and its affiliates ("the Manufacturer") warrants its 
products hereinafter referred to as "the Product" or "Products" to be in conformance with 
its own plans and specifications and to be free of defects in materials and workmanship 
under normal use and service for a period of 12 months from the date of shipment by the 
Manufacturer.  The Manufacturer's obligations shall be limited within the warranty 
period, at its option, to repair or replace the product or any part thereof.  
This warranty does not apply in the following cases: improper installation, misuse, 
failure to follow installation and operating instructions, alteration, abuse, accident or 
tampering. 
This warranty is exclusive and expressly in lieu of all other warranties, obligations or 
liabilities, whether written, oral, express or implied, including any warranty of 
merchantability or fitness for a particular purpose, or otherwise.  In no case shall the 
Manufacturer be liable to anyone for any consequential or incidental damages for breach 
of this warranty or any other warranties whatsoever, as aforesaid. 
This warranty shall not be modified, varied or extended, and the Manufacturer does not 
authorize any person to act on its behalf in the modification, variation or extension of 
this warranty. This warranty shall apply to the Product only.  All products, accessories 
or attachments of others used in conjunction with the Product, including batteries, shall 
be covered solely by their own warranty, if any.  
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The Manufacturer shall not be liable for any damage or loss whatsoever, whether 
directly, indirectly, incidentally, consequentially or otherwise, caused by the 
malfunction of the Product due to products, accessories, or attachments of others, 
including batteries, used in conjunction with the Products. 
The Manufacturer does not represent that its Product may not be compromised and/or 
circumvented, or that the Product will prevent any death, personal and/or bodily injury 
and/or damage to property resulting from unauthorized entry, burglary, robbery, or 
otherwise, or that the Product will in all cases provide adequate warning or protection. 
User understands that a properly installed and maintained access control system may 
only reduce the risk of unauthorized entry without warning, but it is not insurance or a 
guarantee that such will not occur or that there will be no death, personal damage and/or 
damage to property as a result. 
The Manufacturer shall have no liability for any death, personal and/or bodily 
injury and/or damage to property or other loss whether direct, indirect, incidental, 
consequential or otherwise, based on a claim that the Product failed to function.  
However, if the Manufacturer is held liable, whether directly or indirectly, for any loss 
or damage arising under this limited warranty or otherwise, regardless of cause or origin, 
the Manufacturer's maximum liability shall not in any case exceed the purchase price of 
the Product, which shall be fixed as liquidated damages and not as a penalty, and shall 
be the complete and exclusive remedy against the Manufacturer. 
 
Document revision 8/2003 
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About This Manual 
This manual provides a detailed description of the procedures for using the PowerMax 
Remote Programmer with your PowerMax system. Consult PowerMax Programming 
Guides for additional information about specific programmable parameters. 
Chapter 1 provides an overview and briefly describes the system. 
Chapter 2 lists the requirements for installing the software and describes the software 
installation process. 
Chapter 3 covers the menus included in the software. 
Chapter 4 introduces Sites and how they are managed (creating, saving, deleting and 
copying). 
Chapter 5 explains how to manage PowerMax Remote Programmer users, including how 
to add users, delete users, change a user’s password and how to log in as a different user. 
Chapter 6 details all the different tables displayed in the software and provides a general 
overview of what is included in them. 
Chapter 7 describes how to connect to the PowerMax. This chapter details the different 
connection types and available settings, how to connect/disconnect to the PowerMax 
and what online functions are available when connected. 
Chapter 8 describes how to download/upload customized data settings. 
Chapter 9 covers the Reports utility, detailing how to define and generate reports. 
Chapter 10 describes how to change the screen appearance, change the screen color, 
column alignment and user interface language. 
Chapter 11 provides answers to troubleshooting questions, which may occur. 
Appendix A provides solutions in the event of characters not appearing correctly due to 
the interface language used. 
Note: Throughout the manual, both PowerMax and PowerMax+ are referred to as 
“PowerMax”. When necessary to relate to a specific model, this model will be 
mentioned specifically. 
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Formatting Conventions 
The following formatting conventions are used throughout the documentation: 
Note: Additional information relevant to the presently 

discussed subject. 

Warning: 
Caution: 

Information that is essential for your safety and to avoid 
damaging the hardware or software. 

bold text Indicates operations that you must perform (e.g., name 
of a button to be clicked or option to be selected) or to 
emphasize a field or concept being described. 
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Chapter 1: Introduction
The PowerMax Remote Programmer is a utility program that enables you to manage the
PowerMax alarm system from a remote station. It runs on IBM-PC or compatible
workstations and runs on Microsoft® Windows® 95, 98, Windows NT®, Windows 2000 or
Windows XP.

It allows offline preparation of specifications, each of which is a set of parameters
especially tailored for a particular PowerMax installation site. After the user has prepared
the parameters for the site, he can download them into the PowerMax control panel on the
site.

Data is transferred to and from the PowerMax Remote Programmer either locally through
an RS-232 serial data cable, as shown in figure 1, or remotely via telephone lines and a
modem, as shown in figures 1.2 and 1.3.

Local Data Transfer enables the operator to prepare the parameters for the PowerMax
alarm system on a PC where he specifies parameters in the Site Screens, even though he is
working at the same installation site. He then transfers the data to the alarm system through
a cable.

Figure 1-1: Setup for Local Data Transfer

Remote Data Transfer enables the operator to work from a remote site where he can control
several PowerMax systems at different installation sites. Using the PowerMax Remote
Programmer, he can compare the parameters of the different systems and copy them if
necessary. The data is then transferred to each PowerMax through a modem.

Figure 1-2: Setup for Remote Data Transfer with an External Modem

Figure 1-3: Setup for Remote Data Transfer with an Internal Modem
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Chapter 2: Getting Started  
2.1  Hardware / Software Requirements 

In order to run PowerMax Remote Programmer, you need the following resources: 

• IBM-compatible PC with Pentium microprocessor (100 MHz or higher) 

• Microsoft® Windows® 95, 98, Windows NT®, Windows 2000 or Windows XT.  

• 16 megabytes of RAM (minimum) 

• Hard disk with at least 8 megabytes of free space. 

• For best performance, use a display driver with a resolution of at least 1024 x 768 pixels. 

2.2  Installation 
Install an internal modem in the computer, or use an RS-232 cable to connect an external 
modem to one of the computer’s COM ports as instructed in the manual supplied with the 
modem. Then connect the modem to the telephone line. The modems suitable for use with 
PowerMax Remote Programmer are listed in the Modem field in the Communications tab 
of the Options window (refer to 7.1.2 Remote Connection). 

To Install the Modem  

1. Install the modem for use with the remote computer, whether internal or 
external. 

2. Restart your computer. In most cases Windows will detect the new hardware 
and will open a dialog box prompting you to install the driver for the new 
modem (from the manufacturer’s CD). 

If Windows does not recognize the modem during startup, do the following:  

3. From the Start menu, select Settings, then Control Panel; the control panel 
window appears.  

4. Double-click the Modems icon; the Modem Properties dialog box appears.  

5. Click Add; the Install New Modem wizard begins. Follow the instructions to 
enable Windows detect and install the new modem. 

To Install PowerMax Remote Programmer 

1. Start Windows. Close all running applications, if any. 

2. Insert the PowerMax Remote Programmer CD into the CD-ROM drive. 

 If your system includes the AutoPlay feature, the setup program starts 
automatically. Otherwise, proceed as follows: 
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3. From the Start menu, select Run; the Run dialog box appears.  

4. In the Run edit box, type the drive letter of the CD drive you are using, followed 
by a colon, backslash, and the word “setup”, for example: "d:\setup". 

5. Click OK. The installation welcome screen appears and the Installation program 
guides you through the entire process. 

6. Click Next, then follow the instructions on your screen to complete the 
installation.  

7. Restart your computer when the Installation wizard prompts you to do so.  

During installation a PowerMax shortcut icon is placed on the Desktop to 
enable you to start PowerMax Remote Programmer easily. 

 

To Start PowerMax Remote Programmer 

1. On the Windows Desktop, double-click on the PowerMax Remote 
Programmer icon; the Login screen appears. 

 
Figure 2-1: Login Screen 

2. In the Operator edit box, type visonic. 

3. In the Password edit box, type powermax, then click OK. 

 Both entries are case-sensitive - use lowercase letters. 

 The main PowerMax Remote Programmer screen appears with the Sites List in 
the foreground as the active window.  
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Figure 2-2: Site List Window 

This window enables you: to open an existing site file; create a new site file; copy a site 
file; delete a site file or exit the program. Refer to “Chapter 4. Sites” for further details. 

2.3  PowerMax Remote Programmer Main Window 
The PowerMax Remote Programmer main window displays all the main features of 
PowerMax Remote Programmer. This enables you to manage the PowerMax alarm system 
easily and efficiently.  

 
Figure 2-3: PowerMax Remote Programmer Main Screen 
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Title Bar 
The title bar displays the following features: 

• The name of the PowerMax Remote Programmer file that you have opened. 

• The windows Minimize button.  

• The windows Maximize button.  

• The windows Close button. 

Menu Bar 
Displays the menus that enable you to access PowerMax Remote Programmer features. 

List of Tables 
This area displays a list of all the data tables containing information which characterizes 
the site. As you point to each table title, it appears underlined. Click on a title to display 
that table data. 

Table Data 
This area contains detailed data included in the selected table.  

Type in settings, or double-click on the down-pointing arrow to display a drop-down list, 
and select the appropriate value. 

Toolbar 
PowerMax Remote Programmer provides a toolbar that displays ten buttons which 
are shortcuts to the most frequently used features of the system. 

Button Name Function Also 
accessible 
through menu 

 

Sites Displays the Sites List window. Sites 

 

Options Displays the Options dialog box. View 

 

Save Saves the site file displayed on the screen. Sites 
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Print Displays the Print dialog box. Sites 

 

Back  Displays the previous table according to the List 
of Tables. 

View 

 

Next Displays the next table according to the List of 
Tables. 

View 

 

Login / 
Logout 

Connects/disconnects the PowerMax Remote 
Programmer to/from the control panel. 

Communications 

 

Download Downloads data from the PowerMax Remote 
Programmer to the control panel. 

Communications 

 

Upload Uploads data from the control panel to the 
PowerMax Remote Programmer and 
automatically updates files. 
Note: To upload event logs/scheduler in 
PowerMax+, see Chapter 8: Data. 

Communications 
 

 

Download 
Table 

Downloads data from the table currently visible 
on the screen to the control panel. 

Communications 
 

 

Upload 
Table  

Uploads data from the control panel to the table 
currently visible on the screen (available in 
PowerMax+ only). 

Communications 
 

 

Help Displays the PowerMax Remote Programmer 
Help files. 

Help 

Status Bar 
The Status Bar appears at the bottom of the PowerMax Remote Programmer screen. 
It displays the following: 

• Menu name 

• Caps lock 

• Number lock 

• Communication Status: The communication status is displayed by the color of the two 
communication status icons:  

Program Status Left Icon Right Icon 

Communication is offline Gray Gray 
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Communication is online Dark green Dark green 

Downloading to control panel Dark green Light green 

Uploading from control panel Light green Dark green 

• PowerMax model: Displays the PowerMax model name. 

• Control Panel State: Displays the control panel state. This can be one of nine states: 
disarm, exit delay home, exit delay away, entry delay, home, away, user test, download 
and programming. 

• Note: The State will be displayed only when the software is connected to the 
PowerMax+ control panel. 

2.4  Navigating PowerMax Remote Programmer 
You can move around the PowerMax Remote Programmer screen and carry out functions 
in a variety of ways: 

Mouse 
Use the mouse to point to a position on the screen, then click the left mouse button. This 
enables you to do the following: 

• Click a button. 

• Select a table tab in the main screen. 

• Place the cursor within a table edit box. 

• Display a drop-down list. 

Arrow keys 
The arrow keys enable you to move around the PowerMax Remote Programmer tables and 
highlight the edit boxes. However, they do not enable you to place the cursor at the 
insertion point; you must do that with the mouse or by pressing Enter. 

2.5  Exiting PowerMax Remote Programmer 
At any time, you can exit PowerMax Remote Programmer.  

To Exit the Program 

1. From the Sites menu, select Exit. A popup message appears prompting 
you to save the recent changes to the system.  

2. Click Yes to save or No to disregard recent changes. PowerMax Remote 
Programmer closes. 
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Chapter 3: Menus
The PowerMax Remote Programmer main screen displays five menus, which enable you to
access the different features of the application.

3.1  Sites Menu
The Sites menu provides you with the tools to manage new and existing Sites.
Menu Item Function
List of Sites Displays the Sites window.
New Site Displays a new PowerMax Remote Programmer Site File that contains

default values.
Save Saves an existing Site file.
Save As Enables you to save a site file by a new name.
Print Prints a report.
Print Preview Displays the report on the screen before you print it.
Print Setup Enables you to determine the Print specifications.
User Enables you to manage users.
Exit Exits PowerMax Remote Programmer.

3.2  Edit Menu
The Edit menu contains commands that help you edit and fill in details in each screen.

Menu Item Function

Undo Undoes all previous actions, up to the most recent save.

Cut Removes selected text to a temporary memory known as a clipboard.

Copy Copies selected text to the clipboard.

Paste Places the text being held in the clipboard at the point of insertion.

3.3  View Menu
The View menu contains items that enable you to control the appearance of your
PowerMax Remote Programmer screen.

Menu Item Function

Toolbar Displays or hides the Tool bar

Status Bar Displays or hides the Status bar.

Next Table Displays the next table of the List of Tables.

Previous Table Displays the previous table of the List of Tables.
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Menu Item Function

Messages
Window

Displays the incoming and outgoing messages.

Options Displays the Options dialog box.

3.4  Communications Menu
The Communications menu enables you to manage the Communication process with the
control panel. All of these functions appear on the toolbar.
Menu Item Function

Login/Logout Begins the login/logout process to/from the control panel.

Update Login
Data…**

Enables updating the download and installer code when system is armed.

Download Downloads data from the Remote Programmer to the control panel.

Upload Uploads data from the control panel to the PowerMax Remote Programmer.
(In PowerMax+, this process uploads all parameters except for the Event
Log. To upload the Event Log use Upload Table)

Download Table Downloads the currently displayed table from the PowerMax Remote
Programmer to the control panel.

Upload Table* Uploads the currently displayed table from the control panel to the PowerMax
Remote Programmer.

Change System
Time & Date…

Sets the time and the date that will be downloaded to the control panel. This
option is only enabled when the communication between PowerMax Remote
Programmer and the control panel is enabled.

Customize
Zone/Sensor
Names*

Enables modification of the five custom names.

Upload
Customized
Zone/Sensor
Names*

Retrieves the updated custom names from the PowerMax.

Port Auto
Detection…

Automatically begins a search for the control panel that is connected by Serial
Communication mode.

* Available in PowerMax+ only.
** Available in PowerMax only.
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3.5  Help Menu
The Help menu enables you to receive information and guidance in managing PowerMax
Remote Programmer.
Menu Item Function

Help Topics On-line Help to increase your knowledge about PowerMax Remote
Programmer, and help you use it to its maximum potential.

About
PowerMax
Remote
Programmer

Provides PowerMax Remote Programmer copyright and version information.
Click on the PowerMax Remote Programmer logo to display our Home Page,
which contains important information about using PowerMax Remote
Programmer.
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Chapter 4: Sites
4.1  Introduction to Sites

PowerMax Remote Programmer enables you to manage Sites in a variety of ways. These
features are accessible either from the menus or from the Site List window.

The Site List window is displayed either when the program is first initiated,
or by clicking the Sites button in the tool bar or by selecting List of Sites in
the Sites menu.

Figure 4-1: Site List Window

This window displays a list of the site names whose files are located in the directory
displayed in the Sites Location field. The first time the program is initiated, the path
displayed will be the path where the PowerMax Remote Programmer is installed on your
computer. In later sessions, the Sites Location field will display the path last chosen (either
typed in or selected using the Browse button). Using the Browse button, it is possible to
locate and access a site file anywhere in the network and not just access site files saved to
your local computer.

Each column of the site list table can be sorted in either descending or ascending order by
clicking on the column title. You can drag the vertical lines that separate the columns to
enlarge or reduce the size of the columns.

The screen displays buttons, which enable you to begin working with PowerMax Remote
Programmer:
Button Function
Open Opens an existing Site
New Opens a new Site
Copy Copies a Site
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Button Function
Delete Deletes a Site
Exit Closes the PowerMax Remote Programmer application. When you

display the Sites List from within the system, the Exit button appears as
a Cancel button. This enables you to remove the Sites List from the
screen, and continue using the application.

Browse Opens the Browse for Folder dialog box, which enables you to locate a
folder where the Site files are located.

4.2  Creating a New Site
You can create a new, empty site file or you can copy an existing file, save it under a new
name, and make the relevant changes to tailor it to a similar setup as the original. You can
create a new site either via the Site List window or directly in the New Site window.

1. Click New in the Site List window,

or

In the Sites menu, click New Site.…

The New Site dialog box appears.

Figure 4-2: New Site Window - Work Online

The New Site dialog box has two tabs:

Work Online: Enables direct operation with the control panel via a serial port or telephone
modem.

Work Offline: Enables defining and changing parameters offline and at a later time
downloading these parameters to the control panel.

By default the New Site dialog box opens with the Work Online tab open.
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Note: It is recommended to work online when creating a new site file, so that the software
will communicate with the control panel and will automatically select the suitable
PowerMax model.

Working Online

To work via a serial port

1. In the New Site window click Options…. The Options window appears.

Figure 4-3: Options - Serial Port Communications Mode

2. Ensure that Serial port is selected in the Communication mode field and that
the serial port details are correct (refer to chapter 7: Connecting to the
PowerMax Control Panel for further details).

3. Click OK.

The New Site window will appear displaying the Work Online tab with the
Phone Number field disabled and the Auto detection checkbox enabled.
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Figure 4-4: New Site Window - Work Online via a Serial Port

4. Enter the download code. The Login button will become enabled.  

5. Check the Auto Detection checkbox if you want the program to automatically
scan the computer ports to detect PowerMax presence.  

Caution! For local download, the PowerMax must be set to the installer mode,
otherwise the software will not detect it (not applicable to PowerMax+).

6. Click Login.

7. If you marked the Auto Detection checkbox, the program will start scanning the
different ports to look for a PowerMax and will then connect to the PowerMax
and verify the download code.

If you did not mark the auto detection checkbox, the program will try to connect
to the PowerMax via the serial port defined in the Communications settings.

To work via a telephone modem

1. In the New Site window click Options…. The Options Communications dialog
box will appear.
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Figure 4-5: Options - Telephone Modem Communications Mode

2. Select Telephone modem in the Communications mode field.

3. Click OK.

The New Site window will appear displaying the Work Online tab with the
Phone Number field enabled and the Auto detection checkbox disabled.

Figure 4-6: New Site Window - Telephone Modem Mode

4. Enter the Phone Number and the Download Code.  

The Login button will become enabled.
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5. Click Login. The Modem Dial Up... window will appear and attempt
connecting.

Figure 4-7: Modem Dial Up...

Working Offline
Work Offline only if you know the PowerMax model you want to connect to.

1. Select the Work Offline tab. The following screen will be displayed:

Figure 4-8: New Site Window - Work Offline

2. Select the relevant PowerMax model.

3. Click OK.

The PowerMax Remote Programmer main screen will appear and the table data details will
include the parameters relevant for the selected model.
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4.3  Saving a Site  
From the Sites menu, select Save, or click the Save button on the toolbar; PowerMax
Remote Programmer automatically saves the site file on which you are working.

When you select Save or click the Save button for the first time after creating a new site
file, PowerMax Remote Programmer automatically displays the Save As screen.

Figure 4-9: Save As... Screen

4.4  Saving a Site File with a New Name
This enables you to save the site file with a new name and in a different directory.

1. From the Sites menu, select Save As; PowerMax Remote Programmer displays
the Save As screen.

2. Enter a suitable name for the new site and locate the directory where you want
to save the file.

4.5  Displaying and Editing Existing Site Files
Once you have created a site, and saved it, you can view it at any time.

1. Either select the site from the recently used files in the Sites menu or in the Sites
List window, select the site name to display and click Open.

2. The PowerMax Remote Programmer main window appears, and displays the site
tables of the selected site.

3. Edit the site tables as necessary.
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4.6  Copying a Site
You can create a new site based on an existing similar site. This is done by copying an
existing site file, saving it with a new name and then making and saving the necessary
changes.

1. In the Site List window, select an existing site file.

2. Click Copy; an edit box appears prompting you for the name of the new site.

3. Type the new site name, then click OK.

The PowerMax Remote Programmer main window appears and displays the
details of the copied site.

4. Edit the site as necessary.

5. Click Save to save the site.

4.7  Deleting a Site
When a Site is no longer active, and it is no longer necessary to store it in PowerMax
Remote Programmer, you can delete it.

1. In the Sites List, select the site to delete, then click Delete, a warning box
appears reminding you that any account that you delete is not retrievable.

2. Click Yes to delete the account, or No to return to the Sites List.

If you click Yes, the PowerMax Remote Programmer main window appears and
displays the last site that was opened.

4.8  Exiting the Site List Window
When you open PowerMax Remote Programmer, the Sites List displays an Exit button.
However, when you display the Sites List from within the application, the Exit button is
replaced by a Cancel button.

Click Exit to exit PowerMax Remote Programmer.  

Click Cancel; the Sites List closes, and the main PowerMax Remote Programmer screen
becomes active.
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Chapter 5: Users
From the Sites menu, select Users; PowerMax Remote Programmer displays a menu that
enables you to manage the PowerMax Remote Programmer users.
Menu Item Enables you to:

Add new user Add a new user name and password.

Delete user Delete a user name and password.

Change password Change an existing user’s password.

Login as different
user

Login as a different user without exiting PowerMax Remote Programmer.

5.1  Adding New Users
1. From the Sites menu, select Users, then Add new user; the Add new user

dialog box will appear.

Figure 5-1: Add New User Dialog Box

2. In the User Name edit box, type the user's name.

3. In the Password edit box, type the user's password.

4. In the Confirm Password edit box, retype the user's password.

5. Check the Full Access checkbox to enable the user to create and delete other
users. If this is not checked, the user will have access to all the sites, but will not
be able to create or delete other users.

6. Click Add; a message box appears confirming the addition of the user to the
system.

5.2  Deleting a User
1. From the Sites menu, select Users, then Delete user; the Delete user dialog box

will appear.
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Figure 5-2: Deleting User Name Dialog Box

2. In the User Name edit box, type the user's name.

3. In the Password edit box, type the user's password.

4. Click Delete; a message box appears confirming the deletion of the user from
the system.

5.3  Changing User Passwords
1. From the Sites menu, select Users, then Change Password. The Change

Password dialog box appears.

Figure 5-3: Changing User Password Dialog Box

2. In the User Name edit box, type the user's name.

3. In the Old Password edit box, type the user's current password.

4. In the New Password edit box, type the user's new password.

5. Click Change; a message box appears confirming the user password change.

5.4  Login as a Different User
1. From the Sites menu, select Users, then Login as a different user; the

PowerMax Remote Programmer Login screen appears.

2. In the User Name edit box type the user's name and in the Password edit box
type the user's password.

3. Click OK; a message will appear to notify that the password has been changed
successfully.
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Chapter 6: Data Details Tables 
The data details tables display the parameters that can be uploaded from or downloaded to 
the PowerMax control panel. When first creating a site file, the values displayed are default 
values, which can be altered to suit the specific system.  

Use the arrow keys to navigate between the cells and focus on the different parameters, 
then click the left mouse button or press ENTER to edit the cell and change the values.  

PowerMax Remote Programmer includes the following tables:  

Note: The table and their contents can change according to the different PowerMax 
models. 

• Site Information 

• User Settings 

• User Codes 

• Keyfob Enrollment 

• Siren Enrollment 

• 1W Keypad Enrollment 

• 2W Keypad Enrollment 

• Zones Definitions 

• Panel Definitions 

• Communications Definitions 

• GSM Definitions 

• PGM 

• Internal Siren/Strobe 

• X-10 General Features 

• X-10 Device Settings 

• RF Diagnostics 

• Event Log 

6.1  Site Information 
Site Information displays general information about the site control panel. 

Panel Site Name: The name of the site where the control panel is installed. By default this 
field receives the name of the PowerMax model detected. 
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System Manager: The name of the System Manager responsible for programming the 
control panel, responding to alarms and other events. 

Address, City, State, and Zip Code: The complete address of the site. 

Panel Phone No.: The telephone number which the PC modem uses to connect to the 
control panel. 

Additional Information: Additional important information about the PowerMax site and 
facilities. 

Download Code: A 4-digit password, including letters A-F, used to enable downloading 
data to the control panel. 

Installer Code: A 4-digit password used to manage the control panel via the built-in 
keypad. 

6.2  User Settings 
User Settings enables you to define PowerMax settings, applicable to each individual site. 

Set User Tel No.: Type the telephone number where the user can be reached while away 
from the site. The control panel will call this number to report the event types defined by 
the installer in the Communications Definitions screen. Do not use any parentheses or 
dashes when typing the number. 

Note: In PowerMax+ it is possible to enter 4 private telephone numbers in this table. 

Last Upload System Time: The software will update this field automatically.  

Last Upload System Date: The software will update this field automatically. 

Set Voice Option: You can either enable or disable the voice prompts and messages.  

Note: You can only hear voice prompts from the control panel, not from the PowerMax 
Remote Programmer. 

Autoarm*: You can select to arm the control panel automatically (at a predefined time). 

Auto Arm Time*: You can define the time to automatically arm the system. 

Squawk*: You can enable or disable the squawk (short siren sound) option upon arming 
and disarming. 

Time Format*: You can adjust the control panel built-in clock to show the time in 
European format (hh:mm) or US format (hh:mm AM/PM). 

Date Format*: You can adjust the control panel built-in calendar date to show the date in 
European format (dd/mm/yyyy) or US format (mm-dd-yyyy). 
*These functions are available in PowerMax+ only. 
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6.3  User Codes 
This table defines the PowerMax users and lists their codes. Only users, whose numbers 
and codes are listed in this screen, can activate the control panel. PowerMax can store up to 
8 user numbers and codes. All User codes must be different from the Duress code and 
Installation code. 

User Number 1 is known as the Master User. He is the only user who has the authority to 
modify the User Settings and User Codes screens. The Master User code cannot be 0000. 

To Enter a User Code 

1. Identify the user number you wish to define. 

2. Enter a four-digit code that is unique to the selected user number. 

3. Enter comments and additional information about this user. 

6.4  Keyfob Enrollment Screen 
A Keyfob transmitter is a multi-button wireless unit. For each PowerMax control panel, 
there are a total of eight transmitters. They enable the carriers to perform certain system 
functions quickly without using the keypad, and therefore improve system efficiency. 

In order that the control panel and the PowerMax Remote Programmer will recognize the 
Keyfob transmitters, each one must be enrolled in the system, and linked to a specific 
ordinal number between 1 and 8. Keyfob initiated events are subsequently identified and 
registered with reference to these numbers. 

This table displays the keyfob ordinal number, the name of the user carrying this 
transmitter, indication whether the keyfob has been enrolled, the keyfob ID, the keyfob 
sync. counter and the keyfob sync. backup.  

The PowerMax Remote Programmer enables enrolling and deleting keyfobs from remote. 

To Enroll a Keyfob Transmitter to the Control Panel 

In order to perform this procedure collect together: 

•  A PowerMax control panel, which will be used to pass the keyfob identifying 
information from the keyfob through to the PC and from there to the customer’s 
PowerMax control panel. 

•  The keyfob transmitter that is to be enrolled and sent to the customer.  

1. Enroll the keyfob transmitter to the control panel as detailed in the PowerMax 
Programming Guide. 

 Note: Remember the keyfob number you enrolled the keyfob to. 

2. Connect and login via serial connection to the PowerMax as detailed in chapter 
7: “Connecting to the PowerMax Control Panel”. 
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3. Upload the keyfob data from the PowerMax. 

4. Write down the keyfob ID, the sync. counter and the sync. counter backup 
numbers displayed on the screen next to the keyfob number you enrolled the 
keyfob to, in the Keyfob Enrollment table. 

5. Logout and disconnect from the PowerMax. 

6. Connect and login to your customer’s PowerMax control panel. 

7. Click the Options icon in the tool bar or select Options in the View menu. 

8. Select the Data tab. 

9. Check the Send updated data immediately checkbox. 

10. Enter the keyfob ID, the sync. counter and the sync. counter backup numbers to 
the relevant keyfob in the Keyfob Enrollment table.  

 Every cell you update will be automatically downloaded to the customer’s 
PowerMax. (Be careful not to change other parameters). 

11. Logout and disconnect. 

Now all you have to do is to send the keyfob transmitter to your customer! 

To Delete a Keyfob 

In the ID column, change the ID to 00000000, and then download to the control 
panel as detailed in chapter 7: Connecting to the PowerMax Control Panel. 

6.5  Siren Enrollment 
A siren is a two-way wireless unit which emits a loud siren and flashes a bright light 
in the event of a burglary. 

The PowerMax Remote Programmer displays all enrolled sirens. 

6.6  1W Keypad Enrollment 
A  1W (one-way) Keypad is a multi-button wireless keypad unit. For each PowerMax 
control panel, there are a total of eight 1W keypads. 

In order that the control panel and the PowerMax Remote Programmer will recognize the 
Keypads, each one must be enrolled in the system, and linked to a specific ordinal number 
between 1 and 8. Keypad initiated events are subsequently identified and registered with 
reference to these numbers. 

This table displays the keypad ordinal number, indication whether the keypad has been 
enrolled, the keypad ID, the keypad sync. counter and the keypad sync. backup.  

The PowerMax Remote Programmer enables enrolling and deleting keypads from remote. 
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To Enroll a Keypad to the Control Panel 

In order to perform this procedure collect together: 

•  A PowerMax control panel, which will be used to pass the keypad identifying 
information from the keypad through to the PC and from there to the customer’s 
PowerMax control panel.  

•  The keypad that is to be enrolled and sent to the customer.  

1. Enroll the keypad to the control panel as detailed in the PowerMax 
Programming Guide. 

2. Connect and login via serial connection to the PowerMax as 
detailed in chapter 7: “Connecting to the PowerMax Control Panel”.
  

3. Upload the keypad data from the PowerMax. 

4. Write down the keypad ID, the sync. counter and the sync. counter 
backup numbers displayed on the screen next to the keypad number you 
enrolled the keypad to, in the Keypad Enrollment table. 

5. Logout and disconnect from the PowerMax. 

6. Connect and login to your customer’s PowerMax control panel. 

7. Click the Options icon in the tool bar or select Options in the View menu. 

8. Select the Data tab. 

9. Check the Send updated data immediately checkbox. 

10. Enter the keypad ID, the sync. counter and the sync. counter backup 
numbers to the relevant keypad in the Keypad Enrollment table.  

 Every cell you update will be automatically downloaded to the customer’s 
PowerMax. (Be careful not to change other parameters). 

11. Logout and disconnect. 

Now all you have to do is to send the keypad transmitter to your customer! 

To Delete a Keypad 

In the ID column, change the ID to 00000000, and then download to the control panel as 
detailed in chapter 7: Connecting to the PowerMax Control Panel. 

6.7  2W Keypad Enrollment 
A  2W (two-way) Keypad is a multi-button wireless keypad unit. 

The PowerMax Remote Programmer displays all enrolled 2W Keypads. 
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6.8  Zone Definitions  
Zone Definitions allows you to attribute one of the zone types to any one of the wireless 
zones offered by the PowerMax. In addition, it allows you to assign a name to each zone 
and determine whether the zone will operate as a chime zone while the system is in the 
disarmed state.  

6.9  Panel Definitions  
Panel Definitions enables you to customize the control panel and adapt its characteristics 
and behavior to the requirements of the particular user.  

6.10 Communications Definitions  
Communications Definitions enables you to set the telephone communication parameters 
to the requirements of the particular Site. 

6.11 GSM Definitions 
GSM Definitions enables you to set the parameters of the GSM unit connected to the 
PowerMax control panel. 

6.12 PGM  
PowerMax control panel can open or close the programmable (PGM) output as a result of a 
certain event or condition. This table enables you to determine the events and conditions 
under which the PGM (programmable) outputs will function. 

Note: In some versions of the PowerMax+, the PGM will also include a scheduler, (see 
6.15 X-10 Device Settings for further details). When the X-10 device settings table is 
uploaded, the PowerMax Remote Programmer will also load the PGM table. However, this 
does not occur the other way around. 

6.13 Internal Siren/Strobe 
This defines the operation of the INT output in the control panel. 
Internal Siren - enables you to activate the output for a certain amount of (Bell) time. 
Strobe - activates the output until the system is disarmed. 

6.14 X-10 General Features  
This screen enables you to set the general features for the X-10 units. The House Code 
must be a letter between A and P that distinguishes this particular PowerMax X-10 unit 
from others. 

6.15 X-10 Device Settings  
PowerMax control panel can control X-10 units. This screen enables you to determine 
settings for each applicable device. 
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Some versions of the PowerMax+ include a scheduler that enables you to set specific times 
for switching the lights on and off and can also be used with the PGM. 

The scheduler allows four regular daily settings and four additional settings per day. 

 
Figure 6-1: Scheduler 

Note: To download/upload the X-10 device settings, you need to select this table and press 
the download/upload table button. For further information, see Chapter 8:Data. 

Note: When the X-10 device settings table is uploaded, the PowerMax Remote Programmer 
will also load the PGM table. However, this does not occur the other way around. 

6.16 RF Diagnostics  
This screen displays the results of the diagnostic test, performed on-site. The diagnostic test 
measures the reception levels of PowerMax sensors installed throughout the protected area.  

The table includes the zone names, the previously uploaded RF level and the RF level 
received in the last test performed. 

The RF Level columns display the reception levels: Strong, Good, Poor or Not OK.  

When connecting to a particular PowerMax for the first time, both of the RF level columns 
will display NOT OK in all the cells, as the site file does not include any information about 
tests previously performed by the PowerMax control panel.  

When uploading data from the PowerMax after a walk test has been carried out, the Last 
RF Level column will display the results of this test and the Previously Uploaded RF Level 
column will continue to display NOT OK. 

When uploading test results from the PowerMax control panel after results have been 
uploaded previously in the past, the results previously uploaded will be displayed in the 
Previously Uploaded RF Level column, and the uploaded results of the test last performed 
will be displayed in the Last RF Level column. 
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6.17 Event Log  
This Event Log displays the different events that the control panel has detected together 
with their details. PowerMax Remote Programmer stores up to 100 events. This table 
includes the event number, relevant zone or user number/code, relevant zone name, type of 
event, date and time. 
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Chapter 7: Connecting to the 
PowerMax Control Panel 

Connecting to the PowerMax control panel enables the PowerMax Remote Programmer to 
transfer information to and from the control panel. The control panel can be connected by 
remote connection (via telephone modem), used when the operator specifies the parameters 
off-site, or by local connection (via direct cable), used when the operator specifies the 
parameters on-site.  

Once connected, it is possible to perform a number of operations, such as, uploading site 
parameters, downloading site parameters or changing system date and time.  

7.1  Defining Communication Settings 
The Communications dialog box enables you to determine the communication settings by 
which the PowerMax Remote Programmer and the control panel will communicate. 

From the View menu, select Options, then click on the Communications tab; the 
Communications dialog box appears. 

 
Figure 7-1: Options - Telephone Modem Communications Mode 
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7.1.1 Local Connection (Serial Port)  

Local connection is used when the PowerMax Remote Programmer is within direct cable 
connection distance from the PowerMax control panel. When using Local Connection there is 
no need for a modem. Only communication ports without installed modem drivers may be 
used in Serial mode. For example, if the modem drivers are installed on the ports COM2 and 
COM3, then ports COM1 and COM4 may be used for connection in Serial mode. 

1. From the Communications mode drop-down list, select Serial Port. The serial 
port parameters are displayed as follows: 
• The Comm port field becomes enabled. 
• The Baud rate field displays 9600, this being the baud rate used for serial 

connection. 
• The Parity and the Stop bits fields do not change. 

 
Figure 7-2: Communications Mode - Serial Port 

2. Change the Comm port, Parity and Stop bits fields as necessary. 

3. Auto-Detection Option: Check the Auto detect PowerMax when program 
starts checkbox, so that when starting the program, the system will 
automatically search for the control panel connected to the communication port. 

 Note: The auto-detection option can also be activated by selecting Port 
Auto Detection from the Communications menu or by checking the 
relevant checkbox in the New Site dialog box. 

4. Click OK. 
 Note: When the auto detection procedure is initiated, either when starting 

the program or when choosing this option in the Communication menu or 
New Site dialog box, the following screen will appear, showing you the 
names of the ports being scanned. 

 
Figure 7-3: Progress Bar 
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7.1.2 Remote Connection (Telephone Modem)  

This is applicable when the PowerMax Remote Programmer is off-site and the PowerMax 
control panel on-site is connected to PowerMax Remote Programmer by a telephone modem. 

1. From the Communications mode drop-down list, select Telephone Modem. 
The telephone modem section becomes enabled, and the serial port parameters 
change automatically to be displayed as follows: 
• The Comm port field becomes disabled and the field value is the 

communications port where the modem is connected. 
• The Baud rate field displays 300, the baud rate used for telephone modem 

connection. 
• The Parity and the Stop bits fields do not change. 

  
Figure 7-4: Options - Telephone Modem Communications Mode 

2. In the Telephone Modem section of the dialog box, select from the Modem 
drop-down list, the modem to use for connecting to the control panel. 

3. Click Settings to display the Modem Settings dialog box, and define the dialing 
and modem parameters. 
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Figure 7-5: Modem Settings 

4. Select Tone or Pulse as appropriate for the dialing mode. 

5. To connect to the PowerMax modem, the local software initiates the dialing 
process. This process includes a number of steps: 

 Step 1: Dialing. 

 Step 2: Waiting 2-4 rings (The dialing process ends if connection is 
made). 

 Step 3: Hanging up. 

 Step 4: Waiting a number of seconds before trying again. 

 Step 5: Beginning the dialing process again. 

 The Try to connect field defines the number of times the dialing process 
should be initiated (step 1-4). The Wait for 2-4 rings during field 
defines the time allocated for the two to four telephone rings (step 2). 
This time needs to be defined as different telephone systems/modems take 
different amounts of time to carry out the rings. 

 Tip: If you are not sure of the time to enter in the Wait for 2-4 rings during 
field, enter a high number (i.e. 100 seconds), initiate connection as detailed in 
Connecting by Remote Connection in this chapter, time on your watch the 
number of seconds your modem takes for 2 rings and then click Hang Up. Enter 
the number of seconds you timed in the Wait for 2-4 rings during field. 
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6. Check the Use only additional initialization commands checkbox to cancel the 
two other options. The Ignore carrier detection checkbox and the Wait for 
dial tone before dialing cause the system to send additional initialization 
commands.  

7. Make sure that the string of characters in the Additional initialization 
commands is correct for the selected modem. 

 If not, click Select from recommended list; the Recommended Modem 
Initialization Strings screen appears. 

 
Figure 7-6: Recommended Modem Initialization Strings 

8. Select the correct initialization string, then click OK; the selected string will 
appear in the Additional initialization commands edit box. 

9. Click OK; the Modem Settings dialog box closes and the Communication dialog 
box appears. 

10. Click OK. 

7.1.3 GSM and Callback (Optional) 
The GSM and Callback communication features are used for performing connection via the 
GSM unit of the PowerMax+.  

Connection between the PowerMax Remote Programmer and the GSM unit improves 
upload/download speed. 

GSM  
There are 2 types of GSM lines: 
• Bi-directional digital line 
• One way digital line 

If the GSM supports bi-directional digital line communication, then set the GSM to the 
same settings used in a telephone modem, (see 7.1.2. for further information). 

Login is performed the same way as with a telephone modem, (see the next section, 
Callback). 
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Callback  
If the GSM unit supports one way digital line communication, then the Callback feature is 
used. 

 
Figure 7-7: Callback Phone Number String 

In the Phone number field the user enters the PowerMax Remote Programmer return 
telephone number.  In the Wait before sending field, the user enters the amount of time (in 
seconds), needed for communication to be established. 

Login occurs automatically, as follows: 

1. The PowerMax Remote Programmer dials the GSM unit number. 

2. The PowerMax Remote Programmer then enters the download code followed by 
the return telephone number. 

3. The PowerMax Remote Programmer disconnects and waits for the GSM unit to 
return the call. 

4. When the GSM unit calls back, the PowerMax Remote Programmer answers the 
call and login is established. 

7.2  Connecting to PowerMax  
The login procedure enables PowerMax Remote Programmer to transfer information to and 
from the control panel and can be initiated either when creating a new site file or when a 
site file is already open. This procedure differs when the communications mode is set to 
Serial Port or Telephone Modem. The first part of the procedure is the same for both 
types of communication modes: 

Caution:  
Local Connection: In order to successfully complete the login process, check that: 
The PowerMax control panel is set to the Installer mode (not applicable to PowerMax+). 
The communication port is defined correctly. 
You enter the correct download code. 

To Login when creating a new site file  

1. Select New Site from the Sites menu, 

 Or 

 Click New in the Sites window. 
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2. In the New Site dialog box, fill in the fields (the fields will be enabled/disabled 
according to the communication mode.). 

3. Click Login. 

To Login when a site file is open 

From the Communications menu select Login, 

Or  

Click the Login icon in the toolbar. 

Connecting by Local Connection (Serial Port)  
After clicking Login, the communication icons in the status bar will become green, and the 
Download and Upload icons in the toolbar become enabled and you have successfully 
logged in. 

Connecting by Remote Connection 
(Telephone Modem/GSM/Callback)  
When connecting by telephone modem, after clicking Login, the Modem dial up dialog 
box appears. 

 
Figure 7-8: Modem Dial Up... 

Device displays the modem specified in the Communications dialog box. 

1. In the Phone number edit box, type the telephone number to which the control 
panel is connected. 

2. Click Connect. The system begins the login process. 

3. To interrupt the dialing process, click Hang Up; the system switches to the 'wait 
12 seconds' mode. 

 The Status indicates the current state of the connection process. 

4. Click Cancel to halt the connection process and return to the main window. 
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7.3  Online Operations 
While connected to the PowerMax control panel, it is possible to perform a number of 
different operations. You can transfer information between the PowerMax Remote 
Programmer and the control panel by uploading or downloading, either all site parameters 
or a specific table. It is also possible to update the system date and time. 

To Download or Upload All Site Parameters 

Note: If you are interested in preserving changes already made in the control panel, it is 
recommended to first upload all parameters, make necessary changes and then download.  

From the Communications menu, select Download or Upload,  

Or 

Click the appropriate icon on the toolbar.  

The system begins to transfer data between the control panel and the PowerMax Remote 
Programmer. The wording on the message box changes according to whether the transfer is 
upload or download. 

 
Figure 7-9: Uploading/Downloading Progress Bar Screen 

At any point during the transfer, click Cancel to halt the procedure. 

When the transfer is complete, a message box appears to confirm successful completion. 

Note: In PowerMax+, this process uploads all parameters except for the Event Log. To 
upload the Event Log follow the To Upload a Specific Table procedure. 

To Download or Upload a Specific Table 

Note: Uploading a specific table is available in PowerMax+ only. 

1. Select a table by clicking on a table name in the List of Tables area, or by 
clicking a table tab at the bottom of the screen. 

2. From the Communications menu, select Download Table or Upload Table.  

Note: Select the Data tab in Options, to determine whether changes will be downloaded 
immediately, as they are made, or only when the download command is chosen. 
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To Update System Time & Date 

1. From the Communications menu, select Change System Time & Date; the 
Change system time & date dialog box appears. 

 
Figure 7-10: System Time & Date Window 

2. In the Current date edit box, type the date. Use the format according to the 
current date settings. 

3. In the Current time edit box, type the time. Use either the 12 or 24 hour clock 
format according to the current time settings. 

4. Click Send; PowerMax Remote Programmer saves the modified date and time, 
and updates the Control Panel.  

To Update Customized Zone/Sensor Names 

1. From the Communications menu, select Customize Zone/Sensor Names; the 
Customize Zone/Sensor Names dialog box appears. 

 
Figure 7-71: Customize Zone/Sensor Names Window 

2. In the Current name list, select the name you want to change. 

3. In the New Name edit box, type the new name (15 characters max.). 

4. Click Send to update the PowerMax Remote Programmer, 

Or 

Click Exit to exit the program. 
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7.4  Disconnecting from the PowerMax 
From the Communications menu, select Logout,  

Or 

Click the Logout icon on the toolbar. 
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Chapter 8: Data 
The data tab is used to define specific upload/download settings to facilitate data transfer.  

8.1  Defining Data Settings 
The Data dialog box enables you to customize specific data settings in the 
upload/download process. 

From the View menu, select Options, then click on the Data tab; the Data dialog box 
appears. 

 
Figure 8-1: Options – Data Tab 

Note: The contents of the Data dialog box differs for each PowerMax version. 

1. Check the Send updated data immediately field, to automatically update 
changed settings from the PowerMax Remote Programmer to the PowerMax 
control panel. 

 Note: If the above field is not checked, the PowerMax control panel will only be 
updated when performing download table or full download. 

Applies only 
to PowerMax+ 
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2. In the Delay after acknowledge during download field, enter a time value (in 
milliseconds) for a delay in sending commands. This field should be used when 
problems in communication is experienced. 

3. In the Download Code field, if a value (four hexadecimal digits) is entered, the 
PowerMax Remote Programmer uses this value instead of the value in the site 
information field when performing login. 

 Note: If no value is entered in this field, then login is performed using the 
download code in the site information table 

8.2  Using Customized Full Upload/Download Data  
Note: The following section applies to PowerMax+ only. 

This feature enables selecting only specific data to be uploaded/downloaded in connection 
with the PowerMax control panel. This saves significant time in uploading/downloading 
data. 

1. Check the Enable customizing Full Upload/Download Data field, to enable 
uploading/downloading of customized settings. 

2. Mark the relevant check boxes to specify the data to be uploaded to the 
PowerMax control panel. 

Attention: Use the exact same customized fields for both uploading and downloading 
in order to prevent inconsistency in the data. 

Note: Click the Next/Prev buttons to see all the available fields. 

Note: When X-10 Device Settings and PGM are selected, the scheduler becomes 
functional (see chapter 6, for further details). 

3. Click OK; the PowerMax Remote Programmer submits to memory the updated 
data. Pressing full upload/download updates the PowerMax control panel with 
the new table settings. 

Note: The regular full upload/download does not include a log file, the X-10 
scheduler or the PGM scheduler. 
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Chapter 9: Reports 
After you have created a site, you can generate a printable report of the site data. To 
generate a report, first define the information to include in the report, preview the report 
and then print it. 

9.1  Defining and Generating a Report 
Each PowerMax Remote Programmer account comprises of 12 tables. You can generate a 
report including information about some or all of these details. After you specify which 
details you require in the report, PowerMax Remote Programmer will generate the report. 

To Define and Generate a Report 

1. From the View menu, select Options, or  

 Click the Options button on the toolbar; the Options dialog box appears. 

2. Click the Reports tab; the Reports dialog box appears. 

 
Figure 9-1: Options – Reports 

Note: The contents of the Options dialog box differs for each PowerMax version. 
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Mark the relevant check boxes to specify the information to include in the Report. 

3. Click Apply; the tables to include in the report are selected, and the Reports 
dialog box remains on the screen for further perusal and selection. 

4. Click OK; PowerMax Remote Programmer generates the report according to 
your specifications. 

9.2  Viewing a Report 
PowerMax enables you to view reports before you print them. This enables you to check 
that you have included all the necessary information in the report. 

To View a Report  

From the Sites menu, select Print Preview. 

PowerMax Remote Programmer displays the report of the site on the screen as you have 
specified for printing in the Options dialog box. This enables you to view the different 
details of the report before you print it. 

Note: Every report automatically includes details from the Client Description screen. 

The Print Preview toolbar enables you to do the following: 
Print Prints the report from the Print Preview screen. 
Next 
Page 

Displays the following page of the report. 

Prev 
Page 

Displays the previous page of the report. 

One Page Displays one page of the report on the screen. 
Two Page Displays two pages of the report on the screen. 
Zoom in Increases the size of the report as it appears on the screen. There 

are three possible view sizes available. 
Zoom out Decreases the size of the report as it appears on the screen.  
Close Closes the Print Preview screen, and displays the main PowerMax 

Remote Programmer screen. 

9.3  Printing a Report 
You can change the print setup for a report. This enables you to determine the following: 
• The printer to print the report. 

• The paper size on which to print. 

• The source from which the printer should take paper. 

• The orientation of the paper. 
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To Determine the Print Setup 

1. From the Sites menu, select Print Setup; the Print Setup dialog box appears. 

2. Specify the printer to where the report will be printed. 

3. Specify the paper size of the paper on which the report will be printed. 

4. Specify the paper source. 

5. Specify the orientation of the paper. 

6. Click OK. 

To Print a Report 

1. From the Sites menu, select Print; PowerMax Remote Programmer displays the 
Print screen or click the Reports button on the toolbar. 

 
Figure 9-2: Print Dialog Box 

This screen enables you to do the following: 

• Select the printer to print the report. 

• Determine the print range. 

• Determine the number of copies of the report, and whether or not they should be 
collated. 

2. Make the appropriate changes, then click OK; PowerMax Remote Programmer 
prints the report. 
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Chapter 10: Screen Appearance 
Any changes to the appearance of the Site screens are made in the Display tab of the 
Options dialog box. 

 
Figure 10-1: Options - Display Tab 

10.1  Changing the Color 
The colors of the Table Details are defined according to the following settings: 

• Table zebra color: Defines the color of every other line in each table. This makes it 
easier for the user to follow the horizontal lines in the table.  

• Table disabled option color: Disabled tables appear in the selected shade. 

• Table normal option color: The color of the text as you type it. 

• Background color: The background color of the tables list and the sites list. 

To Change the Tables Color 

1. From the View menu, select Options; the Options dialog box appears. By 
default, the display tab is active. 

2. Click on the block of Tables zebra color; the color palette appears. 

3. Select a color, then click OK. 

4. Restart PowerMax Remote Programmer. 
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10.2  Column Alignment 

PowerMax Remote Programmer defines the Table Details column alignment according to 
one of the following settings: The Tables Column Alignment determines the width of the 
table columns on the screen. 

• No auto alignment: All columns in the tables are the same width, regardless of their 
contents. 

• Right justified: The columns in the table are all widened in order to cover the entire 
screen. 

• Last column stretched: The last column in the table reaches the right side of the screen, 
however wide the contents of the column. 

• Additional column: An additional column is added to the tables that are too narrow to 
fill the screen. The extra column is the width of the empty space between the last 
column of the table, and the right side of the screen. 

To Change the Tables Column Alignment 

Click the column alignment drop-down arrow, then select an option from the list. 

10.3  User Interface Language  
PowerMax Remote Programmer provides you with the possibility to change the language 
used in the software interface.  

To Change the User Interface Language 

1. Click the Language User Interface language drop-down arrow, then select a 
language from the list.  

2. Restart PowerMax Remote Programmer. 
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Chapter 11: Troubleshooting 
PROBLEM DIAGNOSIS POSSIBLE SOLUTION 

A.  The PowerMax 
Remote 
Programmer 
doesn't identify the 
modem 

A1. Your modem 
might be OFF or 
loosely 
connected.  

A1. Make sure the modem is turned ON. A 
power switch is available on any external 
modem. The light on the front panel should 
illuminate.  
Note: An internal modem is powered up 
when the computer is turned on.  
Check whether the cable connectors are 
fitted securely to their respective ports: 
• The line connector in case of an internal 

modem  
• The line and RS-232 connectors in case 

of an external modem.  
 A2. You may have a 

COM\IRQ 
conflict. 

A2. Check whether you have the correct Com 
port and IRQ settings in your software 
and/or in the Windows Control Panel. Also 
verify that there are no conflicts with other 
devices. 

B.  Failure to com-
municate with the 
PowerMax via the 
modem.  

B1. You may have a 
conflict with the 
definitions in the 
communication 
mode window. 

B1. Make sure you selected the Telephone 
Modem option in the communication mode 
window. Also verify that the correct modem 
and INIT string are specified. 

 B2. Your modem is 
set to work at a 
high baud rate. 

B2. You need to set the baud rate to 300 bps  

 B3. The modem type 
is different from 
the type displayed 
in the OPTIONS 
menu / Com-
munications tab. 

B3. Check that the correct modem type has been 
selected. 

 

 B4. The initialization 
string is the 
wrong one for the 
modem in use. 

B4. Select the correct string from the list of 
Recommended Initialization Strings.  
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PROBLEM DIAGNOSIS POSSIBLE SOLUTION 
 B5. Modem is not 

properly installed 
in operating 
system 
(Windows). 

B5. Make sure that the modem is recognized by 
Windows.  

 If not, click Start → Setting → Control Panel. 
Double click the Modems icon and follow the 
instructions on the displayed Install New 
Modem window. 

C.  PC fails to 
communicate with 
the PowerMax via 
the Serial Port.  

C1. The RS-232 cable 
is disconnected 
from the Com 
Port of your PC. 

C1. Verify proper connection of the RS-232 
cable.  

 C2. The PowerMax is 
not set to the 
installer mode.* 

C2. Set the PowerMax to the installer mode. 

 C3. You may have a 
definition conflict 
in the OPTIONS 
menu/ 
Communications 
settings 

C3. Make sure that the Serial Port option is 
currently selected. 

 

 C4. Your serial port is 
defined to work 
with high or low 
baud rate. 

C4. Make sure 9600 bps option is currently 
selected in the OPTIONS menu / 
Communications. 

 C5. You may have a 
COM Conflict. 

C5. Verify that the correct Com Port is specified 
in the OPTIONS menu / Communications 

D.  You can not log 
into the 
PowerMax.  

D1. The Download 
code is not 
defined in the 
download code 
field. 

D1. Make sure you entered the correct code into 
the Download field. 
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PROBLEM DIAGNOSIS POSSIBLE SOLUTION 
 D2. PowerMax 

control panel 
doesn't allow you 
to login. 

 This is due to: 
 a) The system 

being in Away 
state and the 
control panel is set 
to allow upload 
only at Disarm 
state. 

 b) The system 
being in Exit/Entry 
state.  

D2. a) Disarm PowerMax Control Panel, then 
change upload setting to Any Time.  

  b) Wait until the Exit/Entry state terminates 
and the control panel enters a valid state 
(Disarm/Arm/Home). Then, login again. 

E.  The program 
doesn’t behave 
normally after 
installation. 

E1. You may have 
failed to restart 
your computer 
when prompted to 
do so at the end 
of installation. 

E1. Restart your computer and run the program 
again. 

 

* Not applicable to PowerMax+. 
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Appendix A: Language Settings 
When using the Remote Programmer Software in Windows 2000/XP with a foreign 
language interface, some characters may not appear correctly in the chosen language. This 
may require changing the language settings. 

Changing Language Settings in Windows 2000 

1. From Start>Settings>Control Panel double-click Regional Options. The 
Regional Options dialog box appears. 

 
Figure A-1: Regional Options Window 

2. Click Set Default; the Select System Locale dialog box appears. 

 
Figure A-2: Select System Locale Window 
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3. Click the drop-down list and select the appropriate language. 

4. Click OK. 

5. Restart the computer. 

Windows XP 

1. From Start>Settings>Control Panel double-click Regional and Language 
Options. The Regional and Language Options dialog box appears. 

 
Figure A-3: Regional and Language Options Window 

2. Click on the Advanced tab. 

3. Under Language for non-Unicode programs, click the drop-down list and 
select the appropriate language. 

4. Click OK. 

5. Restart the computer. 
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